:}":_ o - . kE 1
E U]]am Mum(lpal (Ol‘poratlon M Automatic Building Plan Approval System

HANDOUT for ABPAS
Automated Building Plan Approval System

................................................
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Steps to Create application online

1. Please get user id and password from Ujjain Municipal Corporation.

Architect/LE/SE/Supervisor Registration:

Ujjain Municipal Corporation administrator will login into the application using login page to
register developer as follows.

Ujjam Mu pal orporatio ~ Automatic Building Plan Approval System

Downloads Registration Form

 d

utility for 32 bit S » Architect Registration Form

4

Utility for 64 bit OS5 » Engineer Registration Form

4

Utility Manual (Eocth 32 bit & 64 bit) Structural Engineer Registration Form

o o0 0
i i N e

4

PreDCR Sample Drawings ¥ Supervisor Registration Form

Useful Links Member Login
» Citizen Search Login Id . || |
» Owner Search
Password : | |
» Help
» Download Hindi Fonts O remember Me

Copyright @ 2011 - SoftTech Engineers Pvt. Ltd.

ﬁ Administrative Console @-‘\UtODCR

Ujjain Municipal Corporation

Ujjain Municipal Corporation

; =
Department D 2dd X oelete & Export to Excel
Designation
Office_Category Selection Criteria =
Offi
i Total Employee(s): 59
Fost-Office Name D i Office Location |Login History]
Holidays [ Additional Commissioner Building Permission Addtnl. Commissioner Head Office
Hanls [[] Assistant Engineer 11 Building Permission Assistant Engineer Zone-11 Wiew
Documents
[[] Assistant Engineer Zene-10 Building Permission Assistant Engineer Zone-10 Wiew
Road Details
; [] Building Inspector 12 Suilding Permission Building Inspector Zone-12 View
Console [ Building Inspector & Suilding Permission Building Inspector Zone-3 View
» [] Building Inspector 1 Building Permission Building Inspector Zone-1 View
Employes [] Building Inspector 10 Building Permission Building Inspector Zone-10 Wiew
Architect [ Building Inspector 15 Building Permission Building Inspector Zone-15 View
Ergi==r [ Sullding Inspector 2 Suilding Permission Building Inspector Zone-2 View
Struct. Engineer - o - o
- iaw
Supervisor [ Building Inspector 3 Building Permission Building Inspector Zone-3 iew
D [] Building Inspector 4 Building Permission Building Inspector Zone-4 Wiew
List [] Building Inspector 5 Building Permission Building Inspector Zone-5 Wiew
add — [] Building Inspector & Suilding Fermission Building Inspector Zone-5 View
Delete Plot [] Building Inspector 7 Suilding Permission Building Inspector Zone-7 View
EEIEtel=alany [ Building Inspector & Euilding Permission Suilding Inspector Zone-3 View 3
,
List -1 ~

Empowwering Transformation



Go to the Register>Architect tab from left menu panel.

)

Department
Designation
Office_Category
Office
Post-Office
Holidays

Bank
Documents
Road Details

Console

Employee
»»Architect
Engineer

Struct. Engineer
Supervisor

List

Add

Delete Plot
Delete Colony

List

Ujjain Municipal Corporation

Ujjain Municipal Corporation

Administrative Console

@ AutoDCR

Logout

i Add * Delete @' Export to Excel

ol Evport 1o FOF

Selection Criteria

Total Architect(s): 56

Name | Registration No | valid Up to Email 1d Login History|
[] ABHAY GUPTA ARCH/130/2010-  29/6/2013 abhaygupta_1573@yahoe.co.in
anis
[] ABHLIEET PAWAR ARCH/115/2010-  31/3/2011 abhi-2829@yahoo.co.in
2n11

[ Abhishek 2jmera

F Achal Choudhary

[ Alkesh Sharma

[ Are Privanka

[] Arunesh Singh Tiwari
O Atul Patwa

[] Avinash Jashi

[ Bhavesh Chaudhary
O Bheemszen K Mishra

O DEEFTI VYAS

[ af

O Dheeraj Kanungo

[} dinesh Singh Rajpuocrhit

arch/67/2010-2011 31/3/2011
Arch/08/2010-2011 31/3/2011
Arch-06/2010-2011 31/3/2011
arc/001 29/3/2012
Arch/118/2010-201131/3/2011
Arch/19/2010-2011 31/3/2011
ARC/22/2010-2011 31/3/2011
200 12/5/2011
CA-4234/5435
ARCH/07/2010-2011 31/3/2011

30/8/2020

21 30/6/2011
Archf97/2010-2011 31/3/2011
CA-234 26/7/2013

abhiasja@yahoo.co.in

president@ips.org

sr.aruneshtiwari@gmail.com

medel_mellow@yahco.com

bhaveshc@softtech-engr.com
bm@yahoo.com View

deeptivyas@hetmail.com

markassociates2005@gmail.com

Click Add button, following architect registration form screen displays.

Ujjain Municipal Corporation

Department
Designaticn
Office_Category
Gffice
Post-Office
Holidays

Bank
Documents
Road Details

Console

Employee
»»Architect
Engineer

Struct. Engineer
Supervisor

List

Add

Delete Plot
Delete Colony

List

Sef(tT

Empowwering Transformation

© Back

@AmoDCR

Administrative Console

Personal Information

Items marked with * are mandatory

Name

Firm Name

valid Up To

Contact Information

Address1

City
Phone Number

State

Login Information
Login Name
Password

Re-Enter Password

ek

*First

Surname

L @

1
I

I
1
L 1

Registration No

Qualification

Address2

FIN Code

Mobile Number

£
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Enter Architect name, select console, login information and click save button.
Now architect will be registered and listed on architect’s list page as shown above.

The registered architect can login into the application by entering the user id & password to
submit the proposal online as follows.

1. Click on the link provided on website. Please get username and password from DCRcell.

Automatic Building Plan Approval System

Downloads Registration Form
» Utility for 32 bit O3S @ » Architect Registration Form @
» Utility for 64 bit OS5 @ » Enginesr Registration Form @
» Utility Manual (Ecth 32 bit & 64 bit) @ » Structural Engineer Registration Form @
» PreDCR Sample Drawings @ » Supervisor Registration Form @

Useful Links Member Login
» Citizen Search Login Id . || |
¥ Owner Search

Password H | |

¥ Help
» Download Hindi Fonts O remember Me

Copyright © 2011 - SoftTech Engineers Pvt. Ltd.

Teck

Se(t

Empowwering Transformation
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2. After entering username and Password, architect will be redirected default status
page. Architect can see status of submitted proposal/application, pending memo and
message from corporation.

| welcome Arc progania architea) .

-
" Statiis I Srutiny States # - Panding Propassl
S Olagjected & varding Eeanding O nejected O dpproved
" Downboad
Porm List File Ha. | Scruling Status File M. | Date
— A TR n A Am s B R ] B
r Scrainy [T E] T Sarutiny Barding BOLE201 1 201 Wi 28582011
Naw : 00132001/ 19/ WS2 10SeS20L
feady To Submat UL OIS Wi
Crmming NGt
ﬂ:l:n-:»e?: 0014200 1 200 W0 10552011
Resubmit 1
Crramang Nt In
Faarrrat

Scruting Canmot be
Chanig

Submiited Filas
Bramineg Paid

iuI!-;

Approved

Rajected Mo * Mo g
* Prafile . .

Drafile = File Ha. Mema MNa. Date Amount  Payment

; T LA - *essage : Ploase submit preformatted d
 Query Details DD1S/Z0LLST07 WY BPMEC/DEZAL 144752011 ZEETD  pay Mow 9 o
Add Query ODIWZDIL/TIN WEE BPMSC/R0ITA11 106 2001 11z8 Pay How FormfUMC fE893 : ok...recwd

3. Click on Download>Form list on left menu panel to view/print the list of purchased
application forms.

& Ujjain Municipal Corporation E¥ArutoDCR

; | Architect

Status Selection Criteria 2]

Total Forms: 3

®E¥Form Lisk

» Sr.No.| Form No. Application Date Printed Form No.
New 1 Form/UMC/3065  17/7/2013 umc-23/23
ey T S 2 Form/UMC/3064  17/7/2013 234-UMC
re=simt 3 Form/UMC/3083  17/7/2013 23/23

Drawing Not In Format

Serutiny Cannot be
Done

Crawing Failed In Rules

Submitted Files
Drawing Pass in Rules
Crawing Failed In Rules
Approved

Rejected

Erofile
Add Query

Pending Query
Conversion Query 1

Scrutiny Query ed by SoftTech Enginee

SeftTeck

Empowwering Transformation
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4. Click on Proposals>New on left menu panel to submit a new building proposal/application
for building permission.

-
& Ujjain Municipal Corporation Architect EH¥AutoDCR
Welcome dinesh Singh Rajpuorhit { Architect ) Logout
Statue Hsove Esack
; = Applicants filling applicatian for approval of building plans should submit Pre-Formatted AutoCAD drawings for Scrutiny by AutaDCR.
F = Applicant’s Information Items marked with * are mandatory )
orm Lis

Applicant type

Resubmit - - - .

Scrutiny Cannot be
Done

Drawing Failed In Rules
Submitted Fies K ) Rl ]
Drawing Failed In Rules

Approved
Rejected

Owner's Information

Developer's Information
Profile 1= This Building for Self use or Selling purpose? i O selling @ self Use

Add Query
Pending Query
Conversion Query Form Number

Scrutiny Query o

* m7H A, (Form No.) : [select v| St

|

Case Information

* e wTER ---Select-- ~|

| * =t () | |

WA (M)

- YETE ETF (Sq.mt.) | " Total Builtup Area (Sg.mt.) : | ‘

fA=e

| Existing Area (Sg.mt.) : | ‘

Layout

1= thiz a Group housing
project? : OYes @No

= T (Zoneg) ! |Se|ect w * Ward

Colony

YT FHTE (Flot No.) H [# " Plot Sanctioned H ---Select--- ha

I= this plot nearby to any Special road? : Oves Ono

EE] H ---Select-- vl

Layout Details:

SeftTeck

Empowwering Transformation



A. Select zone from “Zone” dropdown.

B. Select ward from “Ward” dropdown.

C. Select colony from “Colony” dropdown.

D. Select Plot number from “Plot No” dropdown.

~I

Layout
« Is this a Group housing

project? : Orves @no
= FH (Zone) |Znne-1. v " ward = |Wﬁl’d-1
* Colony PANCHAMI
* TS FATE (Flot No.) | Plat-10 S “ Plot Sanctioned

Select
1= this plot nearby to any Specia g'l Dyes One

g

-2
p-3
-4

E. Select special road name and Road.

Layout

« 1= this a Group housing
project? :

* GI:FI(Zone]
¥ Colony

* @IS FHF (Plot No.)

Oves @No

‘ Zone-1 v ‘

V‘ (Colony Type: T & CP (Khasra/Other/City) And Colony is: - )

© ward - |'v‘a'ard-1.

=

[PANCHAMI

V‘ {Colony Type: T & CP {Khasra/Other/City) And Colony is: - )

* 1= this plot nearby to any Special ruad?l

L.

Case Information:

Seft

[Plot-10 v |8 “ Plot sanctioned
i @ves Ono Select: vll
‘---Se\ec‘t-- v‘ .

Teck

Empowwering Transformation

Plots on residential cum commercial roads
Flotz on commercial roads as per Corporation master p
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A. Select type of development from “Development Type” dropdown. Development type
can be selected as New Detail Plan/ Alteration/Addition Plan or Renewal.

Case Information

* fowmE EYEn s | [--select-- v
FFETS (Mt.) * | TNew =T (M)
. - . Addition/Alteration Flan X
HEE FF (Sq.mt) + | [Renewal of proposals Total Builtup Area (Sq.mt.)

Existing Area (Sg.mt.)

For Alteration/Addition Plan fill the Previous Sanction Number as well as Previous
Sanction Date.

Case Information
* T R 3 Addition/&lteration Blan v
" (e : * FEE ()

N TS &7 (Sq.mt.) © Total Builtup Area (Sq.mt.) *

- "
&= " Existing Area (Sg.mt.)

B. Enter plot length & breadth, total builtup area and plot Area in plot area box. This
plot area can be changed if desired.

C. Enter existing area in Existing Area box.

SeftTeck
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Auto CAD file:

AutoCAD File

Attachments:

& Attachments -- Webpage Dialog

Click on "Select™ to browse file.

Document Checklist

Mandatory Documents

age No. To Att
O e g -93 (79 = & i
O4fs st = 0
O 5 mw8 5 was, 5 = 0
[ weiea el = 9 q=@ 0

>

”http:,l’,l’priyanka,l’,l’BPnMS.Common,l’CommonPages, \:J Local intranek

Optional Documents

Attach preformatted (Pre DCR formatted) Auto CAD drawing file (.dwg file) by clicking
“Attach Now"” button and selecting desired drawing file (.dwg file) from the desired location
as follows.

] Fremmmeh el T ERARMC L hare o RRLIER e neen it e see ] JMC_test ¢ JIRA 88 Indian Railway % reademail
| 25
prc
Click on "Select™ to browse file.
Architect @AU‘LODCR

R = I

Choose File to Upload

Lock in: | 3 DGwW JE2 [ e W =
[EBperDCR_0063

D

iy Rizme: perDCR_0066
DDCETentS perDCR_0052-Live Sike Plan3
([ perDCR,_0122
Desktop perDCR_01238
perDCR_0137P
http: ffprivanka) [BPAMS  Comman CommanF] ) perDCR_0063
LUCUIIIEIL UKL foe perDiCR_0065

perDCR_0O0&86
perDCR_0032-Live Sike Plans
perDCR_0122

by D " perDCR_0125
O s w2 (A= | | [EBperdcR _013ve

Oa®F ==iw s =
O MEr moE H, EROENE by Metwark
O veafm o% 24 ™ Fenane | = Open |
;I Cancel |
A

| Document Page No. From Page No. To Im

Mandatory Documents

Optional Documents Files of type: IA" Files [%.7)

Empowwering Transformation
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Documents Checklist:

Select mandatory documents from “Mandatory Documents” and optional documents from
“Optional Documents” list by chegfing (selecting) check boxes next to their names. Click

yellow colored attach file icon to attach physical document file (Scanned copies in
.PDF format or images in .jpg format).

Document Checklist

Mandatory Documents

Document Pa':gr?:":ﬂ. Page No. To Attach File
O S YAT-95 (L &% A1 %) 0 0 PP
O+ ==ra = 0 0 B |=
O 78 5 s, $ =% T T S A 0 0 5
(st e B G s e Bl s e R e B e U M el 0 0 0 v

Optional Documents

Document Page No. From Page No. To Attach File
(023 =% AeAEE = & a1 = o 0 S
O &G 2= A9z ez o = 0 0 B s
O] = 3w £ s o o E [

=E
Click IE icon on top/bottom left of the page to submit (create) the proposal.

5. Once proposal is submitted (created) following screen appears with a message in red
color.

Ujjain Municipal Corporation Architect {BautoDCR

Welcome dinesh Singh Raj it ( Architect ) .

Status Edit ¥ Send for Scrutiny  ® Back to List
» General_Details Suilding_Detaile  ESs site tnformation Road_Details Srint Form Colony-Flot_Details

Form List You need to fill General Details, Building Details,Site Information and Road Details to send further.
v

»>New FH A wEEA : Form/UMC/3065 P (Date) : 17/7/2013

Ready To Submit . .

Resubmit Bl icbeake ) : dinesh Singh Raipusrhit (CA-234) @ |Ceankacad T Hew

Drawing Not In Format

Submitted on : 17/7/2013
Serutiny Cannot be e e .
Done T T TR H Under Review o
Drawing Failed In Rules
y Unique Id

Submitted Files

Drawing Pass in Rules User Remarks
Drawing Failed In Rules

e Rejection/Resubmit Remarks
Rejected

¥ Autedcr File(s)
Profile

r Proposal Flow
Add Query
pending Query Proposal Details Form

Conversion Query

Scrutiny Query Memo Details

SeffTeck

Empowwering Transformation
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General Details:

Click on “General Details” icon on the tool bar to enter/select general details of the plot.

General Details

Plot Details
1= the plot in the vicinity of Aerodrome? ' Oves Qo
Is this a Low density Residential area? : Oves Ono
I= this 3 Slum rehabilitation? ! Oves Ono

Plot Abutting Details

----- Select - %
----- Select ---- |V
\West B Select - W
East B Select - W

Select/enter details and click save button to save the entered/selected details.
Building Details:

a) Click on “Building Details” icon on the tool bar to enter/select building details of the
building(s) being proposed.

Caw

Please Fill Building Height in Meters.

Buildings Details
No. of Buildings L0
No of Beds / . No.of
No. Name Use Sub Use Type Seating Capacity Height Floors

SoﬂTzoﬁ
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b) Enter number of buildings being proposed in “No. of Buildings” box and hit return
key (click on page). Number of rows corresponding to enter building numbers will be
populated to select/enter the details as follows.

Save @ Close

Please Fill Building Height in Meters.

Buildings Details

Mo. of Buildings |3

No of Beds / - No.of

No. Mame Use Sub Use Type Seating Capacity Height Floors
i --Select-- A Cetached w

2 --Select-- A Cetached w

3 --Select-- A Cetached w

c) Enter Building name, building use & its subuse, building type, number of
beds/capacity (in case of hospitals/educational buildings (hostels etc)), building
height and number of floors in the building.

d) Click on “Save” button to save the building details.

Site Information:

a) Click on “Site Information” icon on the tool bar to enter/select items in the site visit
check list.

b) Provide site visit information by selecting/entering values to the site visit check list
items.

c) Click Save button to save the site visit information provided.

SoﬂTcoﬁ

Empowwering Transformation
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,-'f Site Visit - Windows Internet Explorer

IH Save ﬁ Reports @ Closze ke

Site Visit Checklist

B ETE HieE T e B 7 L O O
B ST TR e 99eTET 57 cOsf O
BE T T AE OTRTE 7 c OFr O 0
.ﬁWWW?HﬁHET?#Hﬁﬁ?mﬁﬁmﬁﬁﬁﬁﬁ#?ﬁ%ﬂ_{:::::jim
= 9
n e FEFTE T W S D Qg O s
B FETRET 79 & WM o s Qe O s
B TIRIIE SRl E ¥ ® W o s Qe O s
w TET TR SR w e g D Qe O ST
e e e ol i e e o s Qi Qe

S S S S s [ E—
[ |
B @ e |

WIS T AT

It

d) Click Reports icon to generate site visit reports based on the site visit information
provided as follows.

Empowwering Transformation
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'€ Site Visit Report - Windows Internet Explorer Q@
~
i ESaveacopy = % ﬁSearch {-‘":,‘|IbSelec1 ﬁ: ‘ Qv _:J :I| = 4% v @ ‘ o i;l,j - = ‘ Y!’ﬁ‘
4 bl
o ~
@ —
5
a
Ujjain Municipal Corporation
Site Visit Report 3
File No - Form/UMC/3005 =
B e wier e 7 - Ll
B & RIS ETE @ WS F @S W wAw P4sl T TEY FEE TR O (e e
AT = I W T T W A o ThmEs /RS W w R Ofmes e # e
B tooE RS RS STRE R s
oET TES w w23 = D
(Frams, damd, TEL T oY FE) WETET B
L B S wEE e ¥ -
. B ST TEY SIS U7 §F wiES W Tl A9 seT e e T : 56
qmTE F E
B e FREETE T H - : FeTEE o
B FEEET TIE F SEE H - D
B TeEE R THE T SRS § - D AT
o B I T T o H - L0
=
2 B e fe GIETTE SRS B ONSET W - T FiE
=

Road Details:
a) Click on “Road Details” icon on the tool bar to enter/select road details.

b) Select Yes/No option to indicate whether the road is approved or not. If yes option is
selected, enter Bill No and date.

/= Road Details - Windows Internet Explorer

save [ Close #

Road Details
Water / Drainage Sanction

- EEREEA T : Oves One

SeftTeck
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/= Road Detalls - Windaws Iatermet Fxplrer

see G| [ Come £ ]

Rosd Delails
‘Waler | Drainage Sasction
- guehynd? :]Nz
o v : " T @a

c) In case No option is selected (i.e. if road is not approved), following information
(Water Excavation Details) need to be provided.

Empowwering Transformation
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7~ Road Detalls - Windows Internet Explarer

[ Seve w[ Clase Y

Road Details

Water | Drainage Saaction

whahgy 2 - ow[ow]

Water Excavation Detals
e firgt e 7 =
TrA TR ¢ S|
=T ? z.of
ey e aperd 7 =
Dransge Luoavation Details
wrest firdl opd ? o
WA IS wgrd L
T T e =

a
:
i

d) Enter water excavation information and click save button to save the information
provided.

Printing Form:

Click Print Form icon from the tool bar to print the application/proposal form (hard copy).

Empowwering Transformation
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TTfesT M. 3=

(s farsm)
(afefire ‘%)
hr Bz e vhem 7
7.5 51 Tamwmm frm =it o 17(1) % srta Tt aem & fawm, Fai, gq:Fmin s fadt am & oheds w0 % T
YUYW HAAEA-T
AT WA,
BRI HEA AATHEH,
HEle,
# TS BRI AR A S0 & 1 R g A= Aok A 6 e e e i FA Plot10

T A, 9 A, 1963 % 999 25 NEW o AR G, T, T FAN SEa THad- w1 weal § AR5 560 6
T T CA-234 ATEIAS AL TS T T, ST FEE (79 T e 9) dinesh Singh Rajpuorhit F 38 T FE
1 T T, G A T H SEAANT T @ A FETE T 9 Al § S w0 -

(1) FE=tE®

(2) =@

(3) T P AT
(%) = T

() e S

(%) =eTEal ST T T
(\s) Tame Tl &

T T E o w6 SEien e A ST gE F Aot w0 i e 9 |
A 17/7/2013

SeftTeck
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Colony Plot Details:
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a) Click on “Colony-Plot-Details” icon on the tool bar to view the colony plot.

& Layout Details - Windows Internet Explorer

" Plot Name

Creation Date ; 17/7/2013

Layout Details

* Elot Sancticned
" Iz this 3 type design Plot?

* 1= Additional Parking Check
reguired?

" 1= This plot = 24007

1= Irregular Flot?

* Maximum permissible Floor Area
Ratic

Marginal Open Space

* Front
* Rear
" side 1

* Side 2

* Maximum Permissible ground
coverage

* Maximum Permissible height Of
buildings

" Area of Road widening

Darrazstinmzl iTrannd aras

Items marked with * are mandatory.

Modifed Date :

: |Eefu:|re 2008

®ne O ves
Oves @no
@ne O ves
@ne O ves

O FAR Factor

® Bfup Area (5g. mt)

:||:|

17/7/2013

(m)
(m)
(m)
(m)

o,
ta

{m)

(Sg.mt)

[£

S et
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6. Sending proposal to DCR Cell fro Technical Scrutiny.

Click on “Send” icon on the tool bar to send proposal for technical scrutiny.

Ujjain Municipal Corporation | Architect E¥AutoDCR

)

Logout

This proposal no. Form/UMC/3065 has been sent for Technical Scrutiny

Status Selection Criteria l=i]
»

Farm List Total Pr Is: 1
v |Status| Pe'T'"‘:::i“" File No. Consultant Owner's Name | Case Type ‘ P“I;g‘t’:a' |Hodiiied on

New 4 3R 30Days Form/UMC/3058 dinesh Singh Rajpuorhit Rajendra New Detail Plan 17/7/2013

»»Ready Te Submit

Resubmit

Drawing Not In Format

Serutiny Cannot be
Done

Drawing Failed In Rules

Submitted Files
Drawing Pass in Rules
Drawing Failed In Rules
Approved

Rejected

Profile

Add Query
Pending Query

Conversion Query
\ \ W Zfpproved M Rejected  J Under Review
Scrutiny Query Powered by SoftTech Engineers PVT. LTD.

7. Generating & printing proposal information:

a) Go to Proposals>Submitted Files tab in architect’ s left menu panel, following
proposal list page displays.

m__

! Status

Status Selection Criteria
" Downlosd
Tolal Proposals: 3
Firm List

e e, Permissian
© Pre Scrutiny Shatus T File Ho, Consultani rener's Hame Case Type
Meve 5 [ﬂ 30 Dava. Parmiuscr 5008 At Priyanks Piyu Hea Datml Blas
Resdy To Submas 4 Y 20 Cays Formiusic
Dirmwrsg Mot _ 1o e
Amachad @ 20 oays o/

Bgaubemnit

Srawing Mot In
Format

Scrubey Canrot be
Done

Crawwng Failed [n
Sdes

¥ -

| * rSubmitted g
riles

ey

Are Priyihiks priyan s aganeal Mes Detail Flas
Arc Privanka e Hew Detail Plan

Bules
Appraved
mejected
¢ Profile |&
Prahile 1

' Duery Details

Empowwering Transformation
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b) Click Form No/File number link, following page displays.

Architect @AumDCR

u

|4. Eac
Srabus =
¥ Downicad | Bring Brapedal Information o) Cewnlsad BOF filg

ey Lt

b Pre Scrulliny .
[T e 3 H Form/ UHC/ 3001 T (Date) = la/TjIo1l
Rgady To Syt
Crawing Not
Artseed
Legubmn
Cirawing Not In wrf ot feursh : r Bavi
Forrnat & Lingder Reviaw 4
SCruling Cannct be
Dl
Drawing Faded In

ules

amey fiv = : Are Pripanis [arefoo1) (B fEmE TER : Hew

Submittad cn 1 1473011

DCRCell Remarks

© Proposals
= rSubmitted Usnr Bomearks
Files
Diraanng Fass i
] ! Autoder File(s)
Appread
Rejected Proposal Flow

* Profile
Brgfile

" Query Details
add Query Hene Details

-

Proposal Details Form

Bardma Fsar

c) Click “Print Proposal Information” icon from tool bar to generate and print proposal
information as follows. This will be used as information/record with architect
regarding proposal submission.

€ Proposal Alert - Windows Internet Explorer = |2 m
£ A B [ £ * 1
EH = @ ﬁ| -{‘Tﬁ‘l]}Seled - ® - 2 |:]|G) s7% |- @‘EB N al __‘
g:mn‘
12|
o ~
@ =
=
=
-9
s Ujjain Municipal Corporation
Case Information
File Mo ¢ Form/UME/ 3005 i - Old city (Madhya Kshetra)
=i S Lay7 /2011 Tozal Buiklip Aron - B89 Sq.m.
fF=w FaEn = New =
oEE o B8 Sg.mt. Existing FAR - @ Squmt.
::::r.‘r::;al Special Use FAR | g0 o0 oy
Lagout
Zone : Zone-1 Ward i Ward-1
n Calony : Damodar Nagar Plat - Other - P-785 W |
_ Celony Type : Colony Cell Calony Is : Logal
. : kihhhh Pin Cada : TITITT

Architect’s Infarmation

Narme : Arc Priyanka
Ernsall 1D : Mobile Mo. : (9860238B545)

Cwner's Information

Address : Pune Ermail 1D

‘Name : Piyu Phone Number © 8546221333

rtz & Attachments

Empowwering Transformation
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8. Send the proposal for Scrutiny:

a) Click on Ready to submit and Select your file to submit

¥ Ujjain Municipal Corporation mé Architect @AutoDCR

¢ Priyankas { Architect )

Taotal Proposals: 3

4 3 30 Days Farm/UHIC/ 3001 Asg Priyarich priyanks agarwal Wew Detail Plan
o B 30 Days. FarmUsC 3002 Arc Priyanka EYu Maw Datail Plan

Crawing Not In
[Fainmat

Scratiny Cannct be

Crawing Faded In
Rules

Submnted Fileg
DCrawing Fass in

Profie 1

b) Click Form No/File number link, following page displays.

|

¥ Ujjain Municipal Corporation et Architect AutoDCR
5]

Hew wE q . : Form, UMC/ 3002 = Fete) 1 lafvfz011
¥ rReady To
Subamit : o 1 R
— oawng Rt | ey = : arc Privanica [arcfoon) [ TEE TER T Hew
- Submitted on ; 14/771011
Aasubmit
Cvaming Mot In = =t farh : Urader Review o

o
Emn pﬁeﬁng Transformation
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c) Click “Send for Scrutiny” button in the tool bar to send the proposal further
processing. Once proposal is sent following screen appears with a message in red
color.

@AutoDCR

Architect

Status
* Download

Selection Criteria

This proposal no. Farm/UHC /3005 has been sent Tor Technical Scrutiny

Total Prapasals: ¥
Permission
Statlus
Type

Formn List

" Pre Scrutiny File Mo.

Cramer's Mame Case Type

Hew

4 3 300y
rrReady To =] z
ul

4 B 30 Days.

Farmy UHC 3001
Farmy'UkC/ 3002
Corawirsg Mok
aftsched
Resubmit
Drawarsg Mot In
Farming
Sorutiry Cannot be
Crone
Drawirsg Failed [n
Rulas
" Proposals
Submitted Files
g FasS
Rules
Approved
Rajeciad

9. Viewing/knowing the proposal status:

T
Are Privanka

privarika agacsal
Py

Maw Dwatad Plarn
Mew Daelail Flan

a) Login as architect by providing login id and password as (arc/arc). Go to the status
page (default) in left menu panel. Following page displays. Here proposals display

under different section based on their status.

Scrutiny Status

JRejected F-.f) Ferding |

File Mo.

Form/UMC/ 3005 1477/ 11

Status
» rStatus
" Download
Farmm List

" Pre Scrutiny

Serutiny Perding

Scrutiny Status

Panding Propousl
& pending ) Rejected O} Approved

File Ho. Date

Hew
Ready To Submet
Dravang Mot
Attached
Aesubmit
Cwavnng Mot In
Format
Scrutiny Cannot be
Daones
Cerawang Failed [n
R ules

"’ Proposals
Submitted Files
Dvmwang FPRES i
Ruleg
Approwed
Rejected

" Profile

Frafile

H

Pl

File Mo, HMemo Mo, Date

Paymant

" Query Details 1

Empowwering Transformation
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Scrutiny Process (DCR Cell)

1. Login into the application as DCR Cell Conversion. Following screen displays after clicking
on DCRCell>Conversion Pending.

Ujjain Municipal Corporation

;’ ‘\

: | DCRCell Conversion @:\thODCR

Welcome DCRCell Conversion ( DCR Cell ) Logout
»
Conversion Pending Selection Criteria ‘ |
Conversion Done m—
Drawing Not In Format Status PE'.I’_';"'::'“" File No. Consultant Owner's Name Case Type | P'B';;’:“' ‘Hodiﬁed on |
& 4 (3 30 Days Form/UMC/2570 Bheemsen K Mishra Prashant Patil New Detail Plan 24/6/2013  24/6/2013
Frofile 4 | (3 30 Days Form/UMC/2997 Bheemsen K Mishra Rajendra Kumar New Detail Plan 24/6/2013  24/6/2013
a9 = 30 Davs Form/UMC/2358 Bheemsen K Mishra Sanket New Detail Flan 25/6/2013  26/6/2013
\ 4 & 30Days Ferm/UMC/3065 dinesh Singh Rajpuorhit Mehit New Detail Plan 17/7/2013  18/7/2013 |
4| & 30 Days Form/UMC/3062 Latika Bhesale Sanjay Joshi New Detail Plan 17/7/2013  18/7/2013
4 [ 90 Days Form/UMC/3023 Latika Bhosale Vedant Dixit MNew Detail Flan 28/6/2013  29/6/2013
1
W Zfpproved M Rejected  J Under Review
£ Tech Engine

2.0pen the proposal from “Conversion Pending” tab of left menu.

Ujjain Municipal Corporation DCRCell Conversion EH¥AutoDCR

;:!;‘\

‘Welcome DCRCell Conversion

» |<3=' Back to List
. 7 7
»»Conversion System_Scrutiny_Reports | ) Run_PreDCR‘ Change_Status
Pending ——
Conversion Done
Drawing Not In Format . .
» FHA. [ FTES AL 5 Form/UMC/3065 17/7/2013
Profile . " . q P fa =
gl & A ] dinesh Singh Rajpuerhit (cA-234) & |EEAGES =S I New
Submitted on : 17/7/2013
T frerd : Under review
Unique 1d
DCRCell Remarks
User Remarks
Rejection/Resubmit Remarks
Autodcr File(s)
Proposal Flow
Proposal Details Form 1
= = - b

Empowwering Transformation
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3.Click on "Run PreDCR" option to verify whether drawing is in PreDCR format by clicking on
option. Here user can view the PreDCR report.

AutoCAD 2009 - NOT FOR RESALE 1675314125-17-07-2013 07-38-405_Sanurag nagar 51.dwg *
Tools Draw Dimension Modify Window PreDCR Help  Express
E DeHORECE XDBES £-) SQaGBAEISEE @

v [ standard v /S| sandard

o9 1R

&
=

+ 88

3
3

O #

o
i

)

~N T

1 [

LR

¥ Layoutl [ Layout2

[ Autodesk DWG. This file is a TrustedDWG last saved by an Autodesk application
or Autodesk licensed application.

Cormand: £ >

PreScrutiny Reports : | ~Select- N Print_

Report on

Technical Scrutiny Report

Summary Detail Objection Land Division PreDCR Report | LD_PreDCR Report

Ujjain Municipal Corporation

Report Generated On: 18

PreDCR Report
DOPreDCR Failed Entities 10

ww.umetiiain.ara

All PreDCR Entities Found OK.

TCArea DetailsTC

Staircase Details

PLINTH
GROUND FLOOR
1) FIRST FLOOR
SECOND FLOOR
PARAPETWALLOUTLINE
Lift Details
Building Name E Floor Name No Area

4. change the drawing status to conversion done/Drawing Not in Format by clicking oon
Change status option.

SoﬂTzoﬁ
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¥ Ujjain Municipal Corporation DCRCell Conversion EBautoDCR
Welcome DCRCell Conversion ( DCR Cell ) Logout
~
; A
»»Conversion |<’:; Back to List =
Pending [€7 system_Scrutiny_Reports Run_PreDCR | & Change_Status
Conversion Done
Drawing Not In Format
» e .
Profile PHA. [ FES T £ Form/UMC/3065
T = : dinesh Singh Rajpucrhit (CA-234) (B koo o ew
Submitted on - 17/7/2013
=T F1 feerdlt : Under review 4
Unigue Id
DCRCell Remarks
User Remarks
Rejection/Resubmit Remarks
Autodcr File(s)
—Propasal Forwarded +Proposal Returned ¥ Proposal Holder #Flow Ends Open/Closs All
v

/= Change Status - Windows Internet Explorer

* Change Status to -- Select -- [+

Drawing Mot in Format

[Conwver=sion Dane

Conversion Done
H

Remarks -

Submit || Close

(£

SeftTeck

Empowwering Transformation
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If status is changed to “conversion done”, proposal is displayed under scrutiny pending in
DCR Cell Scrutiny login for technical scrutiny. If status is changed to “"Drawing Not In
Format”, the architect requires to resubmit the pre formatted drawing and proposal displays
under “Drawing Not In Format” tab of the user’s left menu.

5. Login into the application as DCR Cell Scrutiny. Click on File Number under scrutiny
pending tab.Here user can run Auto DCR, view the AutoDCR report, change the drawing
status to Scrutiny done/Scrutiny Can Not Be Done.

6.Following screen displays after clicking on Technical Data>Run AtuoDCR.

DCRCell Scrutiny @A\LIIGDCR
\‘\,

Submitted
=t 1 7 1 =t
; [2 General Details Building Details | B Run Autncr | B zeports Colony-Flot Detaile |2 Road Detaile ¢ Back

»»Scrutiny Pending
Scrutiny Cannot be
Cone

Scrutiny Done

Attached AutoDCR Files

[ =nurag nagar Si.dwg Added By : dinesh Singh Rajpucrhit Date : 17/7/2013 7:40:31 PM

Pending Memo

Frofile Windows Internet Explorer E\

‘.:) This wil bransFer data for AutaDCR!

J

SeffTeck
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AutoCAD window displays after clacking on 'OK' option for selection of AutoCAD version.

e C:AWINDOWS\system32\cmd. exe

C:~Documents and Settings“dineshssDesktoprcds
Ce>Ge
C:~2>cd C:sProgram Files“SEPL:~AutoDCR UMC_MP~1.8._1

C:=“Program Files“SEPL~AutoDCR UMC_MP~1_.8.1>LoadARX .exe ~pt AutoDCR PreDCR UMCN28
13~ JUL-ADCR_B@5%4_13.-HEW

b Load AutoCAD Application

— Supporting AutoCAD Versions
O AutaCAD 2000
O
O
O
O AutoCAD 2006
O
O
& AutoCAD 2009

Q
O

[ 5et AutaCAD 2009 az Default

k. Cancel

SeftTeck
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After selection AutoCAD version drawing file get open for technical scrutiny

CalEl Form/UMC/3065 1675314125-17-07-2013 07-38-405_Sanurag nagar 51.dwg *
Edt  View Insert  Format  Tool  Draw  Dimenson  Modfy  Window — AutoDCR PreDCR Help  Express

Fcafined SR8 OE XDDES £- SQAQ EEHSED B

v & 150DR v | 3 Standard v | /B Standard

Project Information

Project Detad

Type of Project Euilding Developmen v

o

DfGNIIE00 %0

&

Lapout! / Lapout2 /

[~ Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Vindow/ Object] <real times: _P a

Conmand :

Pickup selected scan items by clicking on Pickup option.drawing by clicking on scan option
on AutoDCR window.

Building |tems [term Colars Lapers Pickup Meth... | Flotable #*

v Plot Layer Yes

Iv¥ Main Road Layer Yes

[ Internal Boad Laver Tez

[ Pathway Layer Yes

[~ Ewxisting Road Layer Yes

| Right Of Way Road Layer Yes

[ Road'widening Color+Layer Tez

" OpenSpace Layer Yes

v SubStucture 113 _SubStructure Layer Yes

[ Amenity 4 0 Layer Yes

™ Besvirea B2 0 Layer Yes

I Individial Plat I | | Auer Y b
< >
Select Color From

{(*) Color Dialog

O Entity Pickup Carcel ] [ Help

SeftTeck
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Technical Scrutiny report can be viewed by clicking on the report button as shown the figure

below.

Ujjain Municipal Corporation

DCRCell Scrutiny

E¥AutoDCR

Submitted

—
el . L 7 1 . et
General Details Euilding Details Run AutoDCR ‘ ¥ reports | Colony-Plet Details Road Details & Back

»»Scrutiny Pending

Scrutiny Cannot be
cne
Scrutiny Done

Attached AutoDCR Files

[ anurag nagar S1.dwg

Pending Memo

Profile

Reports - Windows Internet Explorer

Added By : dinesh Singh Rajpuorhit

Date

+ 17/7/2013 7:40:31 PM

Report on
Technical Scrutiny Report
v I Detail Il Objection | Land Division I PreDCR Report | LD_prencr Report
. Rs t G ted On: 18-07-2013
Check List Report pUSESSLE .
www.umcujjain.org
Proposal Details (Table A) Plot Abutting Details (Table B)
Proposal Number Form/UMC/2065 North ROAD WIDTH - 23.2
ase Type NEW South PLOT NO - 23i23
Proposal Type Residential East CTS NO-CTS-5
[est SURVEY NO - 8T-234
Plot Details (Table C) Project Details (Table D)
Plot Humber Plot-10 | Name of Architect dinesh Singh Rajouorhit
Hame of Owner Mahit
Special Project 001
Location Name Qld City Area
Name Description Regd/Perm Proposed Status
Plot Details
PLOT Plot Area MNA 139.00 oK
Abutting Road NA 9.00 OK
Coverage Area 13.80 (10.00%) 70.98 (51.44%) Failed
FAR Area 1658.00 2233.60 Failed
Consumed FAR 12.0000 16.1855 Failed
Amenity
Amenity Gen Detail AMENITY - Total Area 1.00 0.00 Failed
Parkina b

SeftTeck
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Failed entity displays under Objection report.

/= Print Reports - Windows Infernet Explorer (= =]

rescrutiny Reports 5| ~Select- v
Report on
Technical Scrutiny Report
= 1
Summary ” Detail ” Objection || Land Division H PreDCR Report H LD_PreDCR Report
L I
A
: s Report Generated On: 18-07-2013
Failed List Report R S
www.umcujjain.org
Proposal Details (Table A) Plot Abutting Details (Table D)
Proposal Number Ferm/UMC/3085 ROAD WIDTH - 23.2
ase Type NEW South PLOT NO -23/23 .
Proposal T Residential £ CTS NO -CTS-5
est SURVEY NO - ST-234
Plot Details (Table C) Project Details (Table D)
Plot Number Piot-10 | [Name of Architect dinesh Singh Rajpuarhit
Name of Owner Mohit
Special Project 001
Location Name 0Old City Area
Name Description Reqd/Perm Proposed Status
Plot Details
LOT Coverage Area 13.80 (10.00%) 70.98 (51.44%) Failed
FAR Area 1658.00 2233.60 Failed
Consumed FAR 12.0000 16.1855 Failed
\Amenity
Amenity Gen Datail AMENITY - Total Area 1.00 0.00 Failad
PWork to Plot Margin
51-1(1) Front Side 10.00 3.05 Failed
Rear Side 10.00 1.50 Failed |

User can change status by clicking on 'Change Status' option

{= Change Status - Windows Internet Explorer

* Change Status to - -- Select -- b
-- Select --

Scrutinﬁ Can Not Be Done

Scrutiny Done

&

Femarks -

Submit | Close

[£

SoftTeck

Empowwering Transformation
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If status is changed to “Scrutiny Done”, proposal is displayed under Scrutiny Done tab of
DCR Cell Verification for approval.If status is changed to “Scrutiny Can Not Be Done”, the
architect requires to resubmit the pre formatted drawing and proposal displays under
“Scrutiny Can Not Be Done” tab of the architect and user’s left menu.

7. Login into the application as DCR Cell Verification. Click on File Number under scrutiny
Done tab.Here user can view the AutoDCR report, change the drawing status to Drawing
Pass in rule/Drawing fail in rule/Scrutiny pending.

DCRCell Scrutiny Verify @AUIODCR
-
Y

Selection Criteria

Drawing Pass in Rules
Drawing Failed In Rules

Total Proposals: 2

2 Status | Permission File No. Consultant Owner's Name Case Type Proposal |, yitied on
Type Date
Frofile 4 =) 30 Davs Form/UMC/2591 sj kumar Hew Detail Plan 11/7/2011  11/7/2011
» ‘ 4 (& 30 Days Form/UMC/3065 dinesh Singh Rajpucrhit Mohit Mew Detail Plan 17/7/2013  18/7/2013 |
Summary Report -
DCRCell

Detail Repert - DCRCell

Date Wise DCR Cell
Report

M Approved M Rejected U Under Review

DCRCell Scrutiny Verify

»>Scrutiny_Done & Back to List — ~
i B fes [ Technical_Data & System_Scrutiny_Reports | B Change Status
Drawing Failed In Rules
,
Profile AL [ wEE AL : Form/UMC/3065 T (Date) : 17/7/2013
x ~ ~ ~
i n s FrEfE 1 A : dinesh singh Rajpusrhit (cA-234) & TETE FRFR T New
DCRCell o
Detail Repert - DERCell Submitted on . 17/7{2013
Date Wiss DCR Cell = = e : Under review
Report
Unique 1d
DCRCell Remarks
User Remarks
Rejection/Resubmit Remarks
Autodcr File(s)
Proposal Flow
Proposal Details Form
v

SeffTeck
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& Change Status - Windows Internet Explorer

Change Status to - -- Select -- bl

-- Select --
Scrutiny Pending
Dirawing Failed In Rules

Drawing Pass in Rules

Fail in Rulg|
Femarks

Submit | Close

If status is changed to “Drawing Pass in rule”, proposal is displayed under Drawing Pass in
rule tab of architect and printing pending tab of DCR Cell Printing.If status is changed to
“Drawing Fail in rule”, the architect requires to resubmit the pre formatted drawing and
proposal displays under “Drawing Fail in rule” tab of the user’s left menu.

SeftTeck
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=y
E Architect @.«‘\utoDCR

Ujjain Municipal Corporation

Logout

Status Selection Criteria ‘ |

Total Proposals: 1
| Permission Proposal

Form List

N Status Modified On

Type Date

New | 4 (A 30Days Ferm/UMC/3065 dinesh Singh Rajpuorhit Mehit New Detail Plan 17/7/2013  18/7/2013 |
Ready To Submit

File No. Consultant Owner's Name Case Type ‘

Resubmit

Drawing Not In Format
Serutiny Cannot be
Done

Drawing Failed In Rules

Submitted Files
Drawing Pass in Rules
»>Drawing Failed In
Rules

Approved

Rejected

Profile

Add Query 1
Pending Query

Cenversion Query W Approved M Rejected O Under Review
Scrutiny Query - Powered by SoftTech Engineers PVT. LTD.

Resubmission of “"Drawing Fail in rule” Proposal.

(i) Login as Architect and Click on Pre Scrutiny>Resubmit tab.
(ii) Enter drawing fail in rule file number

(iii) Click on Go button

(iv) Attach updated drawing file by 'Attach Drawing option'

(v) Enter resubmission remark and click on 'Submit' option.

SeffTeck
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'ﬁ.“ Ujjain Municipal Corporation A Architect

Logout

Status

Form List

Ready To Submit

Enter yeur File Ne. H Form/UMC/3065 Please Enter your File Mo. in CAPITAL

Drawing Net In Fermat
Scrutiny Cannot be
Done

Drawing Failed In Rules

Submitted Files
Drawing Pass in Rules
Drawing Failed In Rules
Approved

Rejected

Profile
Add Query

Pending Query
Conversion Query

Engin PVT. LTD.

Serutiny Query |

Ujjain Municipal Corporation Architect {¥autoDCR

,’ ‘&

Logout

~
Status

2 Case Information
Form List

v File No. ;' Form/UMC/3065 Case Type : NEW
New Consultant Name :  dinesh Singh Rajpuorhit Last Submission Date : 18/7/2013

Ready To Submit
»»Resubmit

Dl eolliodinjEotney Ho. of Resubmissions : 0
Scrutiny Cannot be
one

Drawing Failed In Rules Attachments: | Select Drawings

Submitted Files Download Remove | anurag nagar 51i.dwg

Drawing Pass in Rules

Drawing Failed In Rules
Approved Remarks
Rejected

Resubmit with updated drawing

Profile

Add Query

Pending Query

Conversion Query

Scrutiny Query —
Cnline Query ~| 2

Empowwering Transformation
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Resubmitted proposal goes to DCR cell verification via DCR cell conversion and Scrutiny.

DCR cell verify the objection report by clicking on 'System Scrutiny Report'.

If no field items listed than status change as "Drawing pass in rule"

{= Print Reports - Windows Internet Explorer ‘:”E”zl
Preserutiny Reports ;
Report on
Technical Scrutiny Report
Summary | Detail | Objection I Land Division | PreDCR Report | LD_PreDCR Report
- - ~
= . Report Generated On: 18-07-2013
Failed List Report & i
www.umcujjain.org

Proposal Details (Table A) Plot Abutting Details (Table B)

Proposal Number Form/UMC/3065 North ROAD WIDTH-23.2

[Case Type NEW South PLOT NO - 23i23

Proposal Type Residential East CTSNQ-CTS-5
West SURVEY NO - 5T-234

Plot Details (Table C) Project Details (Table D)

Plot Humber Plot-10 | Name of Architect dinesh Singh Rajpuarhit
Hame of Owner Mahit
Special Project 001
Location Name Qld City Area

No Deviated Entity Found.

{= Change Status - Windows Internet Explorer,

* Change Status to : -- Select -- b

-- Select --
Scrutiny Pending
Drawing Failed In Rules

FPasz in rule
*

Remarks

Submit || Close

Empowwering Transformation
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9. Login into the application as DCR Cell Printing. Click on file number under printing
pending tab.Here user can run Auto DCR and generate drawing PDF file.

@AutoDCR

DCRCell Printing

Logout
v
»>Printing Pending Selection Criteria 2]
Erinting Done
; Total Pr Is: 4
Erofile Status Pe'T'"J::“’" File No. Consultant Owmer's Name Case Type ‘ P'B‘;::a' |Mndiiied on
u 30 Days (P. F.) 0014/2011/Z01/W01 Arc Privanka shailaja ‘;I‘i‘f‘i““““'““te"““““ 10/5/2011 11/5/2011
4 30 Days D015/2011/207/W33 Arc Privanka nai New Detail Flan /62011 9/6/2011
4| B 30 Days D003/2013/Z10/W45 Bheemsen K Mishra Frabhu Fal New Detail Flan 25/5/2013  26/6/2013
= 30 Davs Form/UNE/3065(Res-1) dinesh Singh Rajpuorhit Hohit New Detail Plan 17/7/2013 18/7/2013 |
1
W Approved M Rejected O Under Review
Tech Enginesrs

@AutoDCR

DCRCell Printing

Logout

»>Printing

di —
a
[?! Aun .“-uI:JDCR‘ ¥ reports € Back
—

Printing Done

Profile Attached AutoDCR Files

[ anurag nagar S1.dwg Added By : dinesh Singh Rajpuorhit Date : 18/7/2013 12:13:59 PM

Empowering Transformation
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Click on ) to generate printing layout.

S File Edit View Insert Format Tools Draw  Dimension Modify Express AutoDCR PreDCR Window  Help P -8k -8 x
2D Drafting & Annatation v |- DEHHEH 2R ¢ 75 = BhrZE @B
J (%750 DOR_AREATABLE

B2 L AEE ! ? @

FEHEN DEE X ADEAE BT ? @

Layout] £ Layout2

"8 File Edt Yiew Irsert Format Tools Draw Dimension Madify Txpress AutoDCR  PreDCR ‘Window Help P - %Xk -5 x
2D Drafting & Annatatian viEw | | DODWE B e 25 - = BrE22H @3

J "M DCR_AREATABLE

D@magm@ ? @

ZRERNEDRE XEMHE X B[R v @

D

b M Model [/ Lapout2 ) AutoDCR0T / AutoDCRO2 [/ AuteDCRO2 J AuteDCR0A0T /) AuteDCROZ02 / AuteDCRO202 ) AutoDCRO304 { AueDCRO305 / AuoDCROLOE / AuteDCROZO7

SeftTeck
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Click on £ option to convert generated layout in PDF file

E File Edic %iew Insert Format Tools Draw Dimension Modify Express AutoDCR PreDCR Window Help |Typeaquestinn fiar help P - %% -5 x
|| 20 Drattng & Anatatior |ﬁﬁ‘“gﬁ HeRR$ s, 40 ) BRERIY H||
|| %[0 Q& om ocr_sreaTasLe =€ g

AR dEE ! 7@
FROENERE X # 6

Conversion. ..

General

File Mame ~ Source  Destination | Skatus . Description |
@205?142... Ci\Program...  C:\Program... Converting...

e o

A MY Model 4 Layout2 3 AutcDCROT ¢ AuteDCROZ 4 AuteDCROZ 4 AuteDCROZ0 4 AueDCRO2.02 { AuoDCRO3.03 4 AueDCRO3.04 § AutoDCRO2.05 4 AutaDCROZ.0E 4 AutcDCROZ.07

10.Change Status as printing Done from change status option.

&

DCRCell Printing @AutnDCR

»»Printing Pending

Printing Done

Profile
FH A S AL : Form/UMC/3065 FeF (Date) : 17/7/2013
aTefeE w1 A : dinesh Singh Rajpuorhic (CA-234) femrma Sy T New ‘
Submitted on B 17/7/2013
=T 1 feardl : Under review 4
Unigue Id j
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11.Login as Architect to inward "Drawing Pass in rule proposal”. Following screen displays
after clicking on Proposal> Drawing Pass in Rule

“Drawing Pass in Rule”, proposal is displays to architect for inwarding the proposal to
corporation/inward clerk .

Ujjain Municipal Corporation Architect YAutoDCR

Welcome dinesh Singh Rajpuorhit ( Architect ) Logout

Status Selection Criteria

#l

Total Proposals: 1

Form List =
| Permission
Ty, !

» Status File No. Consultant Owner's Name Case Type P':::’:BI Modified Onl

New | 4 = 30Days Form/UMC/3065(Res-1) dinesh Singh Rajpuorhit Mohit New Detail Plan 17/7/2013 18/7/2013 [
Ready To Submit
Resubmit

Drawing Not In Format
Scrutiny Cannot be
Done

Drawing Failed In Rules

g Failed In Rules
Approved
Rejected

Profile

Add Query 1
Pending Query
Conversion Query M Approved M Rejected d Under Review

Scrutiny Query -

Click on File number.Architect can view scrutiny report and drawing pdf file from drawing
pass in rule proposal.

Architect @AutoDCR

atatue ¢ send < Back to List :
P =
» @ Site_visit [ System_Scrutiny_Reports % Drawing_PDF_file
Form List
»
New FE A EEE A : Form/UMC/3065
Ready To Submit . .
Resubmit ST T A H dinesh Singh Rajpuerhit (CA-234) B [EearEaseacs
iz RIS I (s Submitted on ; 17/7/2013
Scrutiny Cannot be R
Done T I TRl H Under review
Drawing Failed In Rules
> Unique Id
Submitted Files
»»Drawing Pass in
Rules User Remarks
Drawing Failed In Rules
approved Rejection/Resubmit Remarks
Rejected
; Autodcr File(s)
Profile
; Proposal Flow
~dd Query
2 Proposal Details Form
Pending Query —
Conversion Query = |
il
Scrutiny Query ~1 Memo Details 3

Empowwering Transformation
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Click on Send option for inwarding proposal in corporation for further process.After click on
send option proposal sent to inward.

Ujsain Municipal Corporation I Architect YAutoDCR

Status

29 send|® Back

Form List
2 Outward Information
o Outward No. + [Form/umc/3085
Ready To Submit
Resubmit * Designation

Drawing Not In Format
Scrutiny Cannot be

Done “ User Notes
Drawing Failed In Rules

z)

* Send To Single window ¢ [s

v-Single window

File Online Submitted.

Submitted Files

»»Drawing Pass in
Rules
Drawing Failed In Rules

Approved
Rejected

Profile

Add Query
Pending Query

Conversion Query
- Z A Pow

Login into the application as Inward Clerk. Following screen displays after clicking on
Proposal>In Process.

Singlewin Window/In-charge Officer @AMODCR
Logout
»
Status Selection Criteria ‘ |
¥
»>In Process preT e
Approved status | Permission File No. Consultant Owner's Name Ccase Type ‘ Cremet |Modiiied on
Rejected 1 (3 30Days 0015/2011/Z07/W33 Arc Privanka ngj New Detail Plan 9/8/2011  9/6/2011
- 4 [ 30Days 0020/2011/Z01/W01 Arc Priyanka priya New Detail Flan 30/6/2011 _ 30/6/2011
Cutward 4 [ 30Days 0019/2013/201/W01 dinesh Singh Rajpuorhit Mohit New Detail Plan 17/7/2013  18/7/2013
1
W ZApproved M Rejected  J Under Review
ech Engineers PVT. LTD

Empowwering Transformation
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Open file by clicking on file humber

U]]aln Muf“(“‘a] (orporaﬂon Singlewin Window/In-charge Officer @EI\MODCR
ingle window ( Single window ) .
»
Status Ed\t €9send M rcknowledgement Letter 7 Back to List
1
v [& create_Memo  BY Document_checklist B Reject Now % Drawing_PDF_file ] Documents_Attachments
»»In Process
Approved
Rejected FH A HES AL : 0019/2013/201/W01 e (Date) ¢ 17/7/2013
,
Outward A= = T : dinesh Singh Rajpucrhit (CA-234) (& eeak oo D New
Submitted on ; 17/7/2013 Drawing Pass in Rules
= feadt : Under Review o
Unique Id

User Remarks

Rejection/Resubmit Remarks

Autodcr File(s)

Proposal Flow

Proposal Details Form

1. Receiving File & documents (Hard copies)

Go to Document Checklist tab Receive and Validate of Electronic/Physical documents by
selecting check boxes next to documents name and clicking the save button.

~
Esave @ cloee
Hard copies received : @ves Ona Received On . [rejo7/z0i @
Status i Under review 4
Mandatory Document Checklist
Index in Physical File
Document Received Remarks Attached File
From To
FAT T (T ) O a8
uff & wom O
fuf mws 7 wEe,F TE W I E A O
sl T o s = A9 9eA e o e - Fe e gl O
e ] b
Optional Document Checklist
Index in Physical File
Document Received Remarks Attached File
From To
— e y

SeftTeck
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H save [ close
CE— )

Hard copies received on

Status Under review 2

Mandatery Document Checklist

Index in Physical File

Document Received Remarks Attached File
From To
FATI T TS (A T A
4fi F =w T
fof mwE W wEe. T WE T I A
ST TART % s w5 A= 9o R w we- wen e =
e B | bt
Optional Document Checklist
Index in Physical File
Document Received Remarks Attached File
From To
s e A = whatett v

2. Create and receive challan payment

Steps-

(I) Click on Create memo

(ii) Enter/Update amount

(iii) Click on save option

(iv) Open memo from memo details
(v) Publish created memo

Create Memo :: - Windows Internet Explorer

ﬂ Save

@ ciose

& pubiish

|Edit Césend W

7
> [S create_Mems Document_Checklist T Reject_Now
»>In Process

Status Letter < Back to List

1
‘% Drawing_PDF

=14 = e Under Review 4

Note : This calculati

Approved File Details
Rejected
g : File No. : 0019/2013/Z01/W01
y wE A wEE A 0019/2013/201/W01 : 5 ;
Outward Owner : Mohit
FrfaE A dinesh Singh Rajpuorhit (CA-24 | Property Addr. @ Zone : Zone-1, Ward
Submitted on : 17/7/2013 Add Payment Details

Payment Date

Architect

: Ward-1, Colony : Head Office,

es

is based on sanction details of drawing and consultant data.

Singh Rajpuorhit
Plot No. : Plot-10,

Unique Id si o

1.
User Remarks 2
Rejection/Resubmit Remarks ;

6.
Autodcr File(s) 7.

8.

Proposal Flow

Proposal Details Form

Description

Building Permission Fees
Renewal Fees

Service charges
Development fees
Gallery and Projection
Compounding charges
Roof Water Harvesting
Labor welfare cess

Amount  Amount BY
System
2000 2000
[i
33504 33504
2004 2004
0
i
i
0
>

Total

Empowwering Transformation

Charges By |
Officer (Tn ”

Total Charges By System|

Tn R=Y'
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Pay Challan:-

Step-

(i) Login as InwardAC

(ii) Click on Memo List>Pending memo

(iii) Click on Pay now option next to memo number
(iv) Enter details

(v) Click on save and print

(vi) Generate receipt

@AutoDCR

Inward A/C

< -
Search Memo ‘ £ ‘
Forms
FormList Total Forms: 2
< Form List
»»Pending Memo i
File No. Memo No. Date Amount (in Rs) Payment
Paid Memo
» 0021/2013/Z02/W16 BPMSC/73/2013 18/7/2013 12,700 Pay Now
Profile Form/UMC/2971 BPMSC/0030/11 12/5/2011 5,000 Pay Now
1
L L -

Empowwering Transformation
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Pay Memo :: - Windows Internet Explorer

!E SavedPrint P Close

Payment Details

Memo No. :  [BPMSC/73/2013 -
File Mo. : 0021/2013/Z02/W16
Total Amount . 12,700.00 *Payable Amount :
* Mode of Payment : O cash & pPayorder O Draft
* Payment Date : |lis/7/2013
* Bank Details ¢ PayOrder No. ¢ [ooooii3235547083 |
Bank Name : [HDFC ~|
Branch Name : [Tilak Road| ]
Payment history =
Receipt No. Payment Date Amount Mode of Payment

Cate (18772013
Receipt Mo : 0014/13 File No. :0019/2013/Z01/W01
Architect Name 1 dinesh Singh Rajpuorhit
Owner's Name i Mohit
Cwner's Address 1 234/23 Anurag Magar.Ujjain
LAmount (in Rs.) : 37,508.00
Amount (in Words) i Rupee=s Thirty Seven Thousand Five Hundred
Eight Cnly
Fayment Mode : PayOrder
Payment Cate 1 17/7/2013

(£

SoftTeck

Empowwering Transformation
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3.Generating Acknowledgment letter

Click on Acknowledgment Letter option on tool bar to generate Acknowledgment
letter.

¥ Ujjain Municipal Corporation

T,
ShrifSmt. Mohit Architect : dinesh Singh Rajpuworhit
234/23 Anireg Magar, Ljain

Case Type - New Date :- 18/7/2013

Property Add :- Zone : Zone-1, Ward : Wand-1, Colony : PANCHAMI, Plot No. : Plot-10,

Your Proposal 0019201 3/Z01/W01 for approval of buildimg plan submitted on 17/7/2013 has besn acoepbed
for further scrutiny.

Al Twrther cormespondence of any kind concemed to this shall be made by the reference of this File Nao.
0019/2013/Z01WD1.

The Architect/Licence hereby confirms, all forms, plans, documents are signed by proper authorities and copies
are attested either by gazetted officer of concemed authority.

We hereby acknowledge the receipt of following documents along with the proposal.
T - (TS T
o % T TETE
T Ton e T, e T S = A
AT TR % Y T W Al S-S A e e )

Ujjain MUNICIPAL CORPORATION

Empowwering Transformation
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4.Sending file to Building Inspector

From proposal information tab, click send button,Select the person (Building Inspector) to
send.

Enter user notes (sending notes/comments)

Click send button and send application to Building Inspector for further processing.

Singlewin Window/ In-charge Officer @AUU}DCR
\\.

' 2
T \_ ¥ Send <|=' Back

»»In Process
Outward Information

Approved
Eejected Qutward Ne. ¢ [oois/2013/Z01 W01
v
G * Designatien
* Send To Building Inspecter . |B1-z-1-Building Inspecter 1 v
User Notes Template i [Please check online file and drawing. Compare it with hard file, check ownership documents
jl==pncies ¢ |Please check online file and drawing. Compare it with hard file,

check ownership documents with previously sanctioned file and
other documents.

SeffTeck
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Login into the application as Building Inspector, following screen displays after clicking on
Proposal>In Process

ey
E Building Inspector Console @:‘\utoDCR

Ujjain Municipal Corporation

Welcome Building Inspector 1 ( Building Inspector )
v

Status Selection Criteria l=]
v

Total Pr I

Approved Status Pe'T'"‘:s:i“" | File No. | Consultant Ovmer's Name Case Type ‘ P“I;g‘t’:a' ‘I“Iodiiied Dn‘

Rejected ] 30 Days 0018/2013/Z01/W01(Res-1)  dinesh Singh Rajpuorhit  Mohit New Detail Plan 17/7/2013 18/7/2013
v

Qutward
v

Profile

1
W Approved M Rejected O Under Review
Fowered by SoftTech Enginesrs PUT. LTD. 4

Open the proposal from Proposal>In process list by clicking file humber link.

;’ ‘&

U]]a“l Humtlﬂal (ﬂl‘pﬂl'ailnrl Fer | Building Inspector Console @AMODCR

Logout
-~
; A
Status Ig" send  * Return Fle ¢ Back to List
= 73 g ol
N B Document_checklist [ site visit [P Technical_Data I Site_ visit_Comments ¥ System_Scrutiny_Reports Sanctions & Reject Now ‘% Drawing_POF file
»»In Process
Approved
Rejected FH AL RS A : 0019/2013/201/W01 JEATE (Date) o 17/7/2013
v
Outward R #1 A : dinesh singh Rajpusrhit (CA-234) THETE FRFT D New
- Submitted on : 17/7/2013 Drawing Pass in Rules
Profile A
T T TR H Under Review 4
Unique 1d
User Remarks
Rejection/Resubmit Remarks
Autodcr File(s)
Proposal Flow
Proposal Details Form
Memo Details .

Empowwering Transformation
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Verify the received documents from Documents checklist tab by selecting verify check boxes
next to documents name and insert verification remarks.

Click save button to save the selection & remarks.

I save @ close

Hard copies received on + [18/7/2013

Status H Under review o
Mandatory Document Checklist
Index in Physical File
Document Received Remarks Verified BI Remarks Attached File
From To
FAI AT (T = =) Fine ~
#fF F == = As expected
= o e E I W TEm e A
TEATSA AT % 3 =1 99T WA At w1 se- Fe ez
e femm | hd
Optional Document Checklist
Index in Physical File
Document Received Remarks Verified BI Remarks Attached File
From To
TTEz i T = T FHE
o oy s o <

Powered by SoftTech Engineers PVT. LTD.

Perform site visit By clicking site visit option.Enter site visit date and site visit details click
on save button for save the selection and remark.

f.; Site Visit - Windows Internet Explorer

E Save ﬁ Eeports '9 Close

*Site Visit Done Date - |[18/07/2013 [£]

Site Visit Checklist

m SETE FieET e 7 @ G

FaE A EEE T BT g EE e e TR TEY 7 WX 9 =OS BT
Rerfer (W & sweran T @ far = %=1 5. fBar =11 S(HT € seian aRkaes o aass 1 g |

eI+ r»“;‘-aﬁ

W ST=TE ST TR SIeTE 87 P O @
mE F TS A SR B 7 : @sT CAEY

e o 7 o e

_r‘r T e T T8 A 99§ F O T8 o &I qel] 7a2l aqmT 9@ F wIe 9,

mve & g t|12] T A
w T AR T I s QW @ TR
B FIHTRET U © U w6 e i RO
w YA SRR T % g W : OwnftE @wwThE
w STET T SRIET B A | ¢ Owfas @ s
o 3 TR AE S ST T A A i ORI O SRR -

SeffTeck

Empowwering Transformation



-49-

Generate site visit report by clicking on Report option.

{Z Site Visit Report - Windows Internet Explorer

7 &
Ujjain Municipal Corporation
Site Visit Report
Site Visit Date - 18/7/2013
File No ; 0019/2013/Z01/W01
» TEEE F A E 7 =
» i T [EVE W W T S EeE W e 12/97-UNC TR T STAN Ve o fh (g # e
P T fir = = &, RE = g ¥ s wieEE |/ uftEdE o T ¥ freem s o Ry
B TS TEY AER ST £ Ml
" FA AET S 87 Bl
TEY TET 1 WE o 10 =
B TS TET TR TR ENS AR F i) Ao eET Sl Tenad o1z
TEAE
" e AT W - SR
B TR e @ wa ;ST
B TR ST TeE ¥ WEAm A - © TR —
B T g S W : s
n e R W SR & W - e
B T WA W TE ¥ A WS 5 A IO WiEE 5 423/234 fieis 18/09/2013 v faEvw
B EETE @ S
Elid : =T
w : T 1
B TS WA W OSSR AF R T T eaS ATE 3w
B T AR e § 2
W T FET A W @ 6EEE 4 fFw F a9 i
B R @ Y AEE @ e W 87
e v
Click on sanction option from open file tool bat to view drawing sanction data.
U]]al“ Muni(ipa| (orporation ﬁ Building Inspector Console ‘% AutoDCR

0 send X retunrile € Backto List

Status

FOst A A 7 e Z A
5 2 Document_Checklist Site Visit [P Technical_Data I Site_visit_ Comments [ System_Scrutiny_Reports

»>In Process

Approved
Rejected FHA  wmES A 0019/2013/201/W01 &% (Date) 17/7/2013
>
ottt ST = A dinesh Singh Rajpuorhit (CA-234) (& fommw Fwwn D New
Y Submitted on 17/7/2013
Profile e
= = et Under Review 4
Unique Id

User Remarks
Rejection/Resubmit Remarks
Autodcr File(s)

Proposal Flow

Proposal Details Form

Memo Details

SeoftTeck
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Sanctioned Data For File No.:0015/2013/2Z01/W01 Case Type NEWO

Property Address: Zone : Zone-1, Ward : Ward-1, Colony : PANCHAMI, Plot No. : Plot-10,

Building - Floor Details

Plot Details

Plot Use

Gross Plot Area
Permissible FSI

TDR Area

Proposed Builtup Area

Existing Builtup Area

Residential

i3
2

133.6

2100

Total BuiltUp Area
Met Plot Area

Permissible Builtup Area

Total Permissible Builtup Area

Excess Balcony

Coverage

All areas are in meter

138

1658

1658

70.98

Average FPlot Depth Average Plot Width

FSI Details

Resi F5I t |133.6 Commercial FSI

Industrial FSI Consumed FSI : [16.1855

Road Width

il
i

Special FSI

|

Sending file to Building Officer

From applicant information tab, click send button,Select the person (Building Officer) to
send.

Enter user notes (sending notes/comments)

Click send button and send application to Building Officer for further processing.

SeftTeck
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Ujjain Municipal Corporation

)

Building Inspector Console

@AutoDCR

Status

5
[W Send [ Back
—

»»In Process
Outward Information

Approved
Rejected Outward No.
,
Outward Designation
E Send To Building Officer
Profile

User Notes Template

User Notes

0018/2013/Z01/W01

| 50-2-1-Building Officer 1

v

[Flease verify

v

Please Verify

Login into the application as Building Officer, following screen displays after clicking on

Proposal>In Process

Ujjain Municipal Corporation

Officer 1 ( Building Officer )

)

Building Officer Console

@AutoDCR

Logout

»

Status Selection Criteria ‘ |
¥

EXIn Process Total Pr L2

Approved Istatus| e File No. Consultant Owner's Name Ccase Type ‘ Creet |Modiiied on

Rejected 4 (3 90 Days (P. F.) 0011/2011/Z01/W01 Ehavesh Chaudhary New Detail Plan 10/5/2011  11/5/2011
» 4 = 30 Days 0019/2013/Z01/W01(Res-1) dinesh Singh Rajpuorhit New Detail Plan 17/7/2013 18/7/2013

Outward

1
W Approved M Rejected J Under Review

Seft
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Open the proposal from Proposal>In process by clicking file number link.

Based on plot area Building Officer Approve proposal or send to City Engineer

Ujjain Municipal Corporation Building Officer Console

7"‘\

@:\utoDCR

Logout

IW Send *® Return File & Back to List

arefe = A : dinesh Singh Rajpuorhit (CA-234) (B femrma Sy T New

Submitted on Drawing Pass in Rules

w1 i e : Under Review o
Unique 1d

User Remarks

Rejection/Resubmit Remarks

Autoder File(s)

Proposal Flow

Proposal Details Form

y S B cocument_checklist B2 sice visic P Technical_oara W, site_visit_Comments & System_scrutiny_Reports B sanctions B Rejecs_Now B Falled_ltems(4/A)
»>In Process % Drawing_PDF_file ¥ Approve
approved
Rejected
b T A ‘EWWI- H 0019/2013/201/ W01 7 (Date) - 17/7/2
Cutward

Building officer verify failed items in drawing.Proposal can be rejected on failed items.

View failed items by clicking on Failed Items option.

Approve/Reject failed items by selection status and insert remarks.

o save @ clese

> Drawing Fail Items

Sr No. Name | Description | Required |Propnsed | Status Concession By Approving Authnritymks | View Noting ‘
1 Plot Details Coverage Area (130.80000 \ (‘_0196o \ proved 2 [By DC Rules EO-Z-1 Approved @
.00%)  (51.44%)
2 Amenity AMENITY - Total Area 1.00 0.00 Approved %/ By DC Rules BO-Z-1 Approved @
3 Worlk to Plot Margin Front Side 10.00 3.05 Approved |w|[By DC Rules BO-Z-1 Approved [&]
4 PWork to Plot Margin Rear Side 10.00 1.50 Approved |w[By DC Rules B0.Z1 Approved @
H Stair Details GROUND FLOOR. PLAN - 1.85 1.00 Approved |w|By DC Rules —— Approved @
STAIRCASE - Int. Landing
width
3 Stair Details GROUND FLOOR PLAN - 1.85 1.00 Approved | v [By DC Rules I Approved ®
STAIRCASE - Floor Landing
width
7 Stair Details FIRST FLOOR PLAN - 1.85 1.00 Approved |w|By DC Rules —— Approved @
AIRCASE - Int. Landing
width
g Stair Details FIRST FLOOR PLAN - 1.85 1.00 Approved v By DC Rules 8071 Approved| @
STAIRCASE - Floor Landing
width

SeffTeck
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Sending file to City Engineer
From Proposal tool bar click send button,Select the person (City Engineer) to send.
Enter user notes (sending notes/comments)

Click send button and send application to City Engineer for further processing.

@.«‘\utoDCR

Building Officer Console

[64 send = Eack

Status

»»In Process
Outward Information

Approved
B Outward No. + |oo19/2013/Z01/Wo1
»
Outward * Designation
* Send To City Engineer H |CE-1-C|t'. Engineer v
User Notes Template : [ Please verify v
“ User Notes Please Vekify

Login into the application as Building Inspector, following screen displays after clicking on
Proposal>In Process.

City Engineer Console @AUTODCR

»ﬁ\

Ujjain Municipal Corporation

Welcome City Engineer ( City Engineer )
»

Status Selection Criteria =]
»

o e Total Proposals: 1

Approved Status PE'{";::"’" File No. ‘ Consultant ‘ Ovmer's Name Case Type ‘ P'B‘;:’:B' Modified ﬂn|

Rejected ] 30 Days 0018/2013/201/W0i(Res-1)  dinesh Singh Rajpucrhit Mohit New Detail Plan 17/7/2013 18/7/2013
»

Cutward
»

Profile

1
B Approved M Rejected  J Under Review
Powered by SoftTech Engineers PVT. LTD

Proposal can be reject on Document Scrutiny/Technical Scrutiny/Site Visit Scrutiny by CE.

Rejected proposal displayed under rejected tab of both Architect and CE.

SeffTeck
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'E% Ujjain Municipal Corporation City Engineer Console @AmoDCR

Welcome City Engineer ( City Engineer )

Status IW send  * Return File € Back to List
; 2 Document_Checkiist B2 site vist [P Technical_Data M. Site_visit_Comments T System_Scrutiny_Reports Sanctions ¥ Reject_iow X3 Failed_ltems(A/A)
»»In Process 5 Drawing_PDF_file ¥ Approve @ Documents_Attachments
Approved
Rejected
- FH A, "F'E.ﬁi H 0019/2013/201/ W01 T (Date) : 17/7/2013
Cutward N . .
: TR = A : dinesh Singh Raipuarhit (CA-234) (A fFEE STEE R
Profile Submitted on . 17/7/2013 £~ Change Status - Windows Internet Explorer, gg|
f o . ~
= T feare Under Revie] i
Unique Id
e —— Documents Rejection.
[¥] pocument Serutiny
Rejection/Resubmit Remarks
Technical Rejection.
V| iny
Autodcr File(s) [l Technical Scrutiny
Proposal Flow Site Visit Rejection.
[ site visit Serutiny
Proposal Details Form o
PE———— &

Sending file to Additional Commissioner

From Proposal tool bar click send button,Select the person (Additional Commissioner) to
send.

Enter user notes (sending notes/comments)

Click send button and send application to Additional Commissioner for further processing.

Empowwering Transformation
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City Engineer Console @ALIU)DCR

Logout

8¢ send ¢ Back

Status

»>In Process
Outward Information

Approved
bgzess Outward No. + |oo1e/2013/701/wo1
y
ot Designatien
. Send To Addtnl. Commissioner . [ADC-1-Additional Commissioner v
Profile
User Notes Template i [Please verify v
User Notes ¢+ [Please verify

£

Login into the application as Additional Commissioner, following screen displays after
clicking on Proposal>In Process

@AmoDCR

Addtnl. Commissioner Console

Logout

,

Status Selection Criteria =l
,

Total Pr I

Approved Istatus| Pe'T'"‘:::i“" File No. Consultant Owmer's Name Case Type ‘ P“I;g‘t’:a' |Modiiied on

Eeinasc a2 B 30 Days (P. F.) 0014/2011/Z01/W01 Arc Priyanka shailaja ‘:Ida‘ﬁti““a"'“te"ati”" 10/5/2011 11/5/2011
,

rofro u 30 Days 0018/2013/Z01/W0i(Res-1)  dinesh Singh Rajpuorhit Mohit New Detail Plan 17/7/2013 18/7/2013
3

Inward Case Report

Sanctioned Report

Revenue Report

1
B Approved M Rejected o Under Review
N N R

Empowwering Transformation
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Status

»»In Process
Approved
Rejected

Cutward
Inward Case Report

Sanctioned Report
Revenue Report

Ujjain Municipal Corporation

-56-

Addtnl. Commissioner Console

@AutoDCR

Logout

Proposal Approval:

button.

{= Change Status - W

Remarks

~
|X- Return File % Back to List
‘ Document_Checklist [ Site visit [0 Technical_Data M. Site_Visit_ Comments [ System_Scrutiny_Reperts Sanctions & Reject_Now X3 Failed_Items(A/A)
% Drawing_PDF file ¥ Apprave R Documents_Attachments
FHA wEEA 0019/2013/201/wWo01 T (Date) 17/7/2013
AT =1 A dinesh Singh Rajpucrhic (CA-234) & |Eeaska-can New
Submitted on 17/7/2013 Drawing Pass in Rules
e feereh Under Review o
Unique Id
User Remarks
Rejection /Resubmit Remarks
Autodcr File(s)
Proposal Flow
Proposal Details Form D |
s = A
Click on Approve option from tool bar.Enter Approval remark and click on submit
dows Internet Explorer, E]
L
found ok and Approved
Submit || Close

[£

Empowwering Transformation
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Proposal getting approved and approved displayed under approve tab of Additional
commissional login.

)

Status

In Process
»>»>Approved
Rejected

Outward
Inward Case Report

Sanctioned Report
Revenue Report

Ujjain Municipal Corporation

Addtnl. Commissioner Console

@AmoDCR

Logout

Selection Criteria |=]
Total P Is: 1
5tatu§| Pe’_}"i“i"" File No. | Consultant Owner's Name Case Type P'g"‘a“t’:a' Modified On
= (= 30Days 0019/2013/Z01/W01(Res-1) dinesh Singh Rajpuorhit Mehit New Detail Plan 17/7/2013  18/7/2013
1
W Approved W Rejected 4 Under Review

Open approve proposal by clicking on file number.

Status

In Process
»»Approved
Rejected

Cutward
Inward Case Report

Sanctioned Report
Revenue Report

Addtnl. Commissioner Console

@AutoDCR

Logout

IW send ¥ Backto List

7 i
E Site_visit_Comments B System_Scrutiny_Reports Sanctiens ¥ Drawing_PDF_file

) cocuments_attachments

A EES A : 0019/2013/201/W01

TR 1 A : dinesh Singh Rajouerhit (CA-234) @
Submitted on : 17/7/2013

= F feed : Approved W

Unigue Id

User Remarks

Rejection/Resubmit Remarks

Autodcr File(s)

Proposal Flow

Proposal Details Form

Memo Details

Empowwering Transformation

7 (Date)

fammTe E=YFER

Remark: found ok and Approved

17/7/2013
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Sending file to Inward Clerk
From Proposal tool bar click send button,Select the person (Single Window) to send.
Enter user notes (sending notes/comments)

Click send button and send application to single window for issuing permit certificate.

Addtnl. Commissioner Console

@Auto DCR

[89 zend © Back

Status
»

In Process

»>Approved Outward Information

[ezeEe Outwsrd No. + |oo19/2013/Z01/ w01
,

Outward * Designation
,

* Send To Single window : |Sl'v‘4'-5mg\e window v

Inward Case Report

e onerlRemt User Notes Template i [zelea v

Revenue Report ' . P

k User Netes : Proposal approved please issue permit certificate.

Login into the application as inward (Single Window), following screen displays after clicking
on Proposal>Approved

Singlewin Window/In-charge Officer @AMODCR

@‘ Ujjain Municipal Corporation

Welcome Single window ( Single window )

Logout

¥
Status Selection Criteria =
»
f
In Process el 23
E¥Approved Status PE'T'";::“’" File No. | Consultant Owmer's Name Case Type ‘ P'B‘;‘t’:“' Modified On
Rejected ® 3 20 Days Latika Bhesale Sanket New Detail Plan 18/7/2013  18/7/2013
¥ ® (3 30 Days Latika Bhosale Pratik New Detail Plan 18/7/2013  18/7/2013
Outward w3 30 Days Latiks Bhasale Hshitija Mew Cetail Flan 18/7/2013 18/7/2013
® 3 20 Days Latika Bhosale Omkar New Detail Plan 18/7/2013  18/7/2013
®m [ 30 Days 0019/2013/Z01/W01(Res-1) dinesh Singh Rajpuorhit  Mohit New Detail Plan 17/7/2013 18/7/2013
12
W Zfpproved M Rejected U Under Review
ch Engineers PVT. LTD

Empowwering Transformation
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Open file by clicking on file number.

Usjain Municipal Corporation Singlewin Window/In-charge Officer

Status

- Proposals
In Process
»»Approved
Rejected

Outward

@AutuDCR

FHA [ FEEA : 0019/2013/201/ W01 e (Date) 1 17/7/2013
AT A : dinesh Singh Rajpusrhit (CA-234) (& [eeat-a-cacs D Mew
Submitted on H 17/7/2013 Drawing Pass in Rules

= = et g Approved m Remark: found ok and Approved

Unique Id

L]
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Click on final note option form tool bar to generate permit certificate.

neye ¥ sy foemma sfufam a9 1984 & it & w27
HEted, T gifes fm, 3=t

wa fmior s

5. =1, Mohit TH/qfm =,

SO F. Plot-10 FTEHT AT PANCHAMI

) o v = farmr fmmm vy Wi i =g = o 9 5779 = FAF Form/UMC/2065 5T 17/7/2013 = 524 5 wem fAma s
Tefem 999 74T T = ST T T S e E -
(7) =% Tl e A 17 A s T 2014w TETSETE T |
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